User Manual for external users of Unibox
Inhalt

1. Introduction ........................................................................................................................................... 3
2. Accept invitation ....................................................................................................................................... 3
3. Login ........................................................................................................................................................ 4
4. Utilization ................................................................................................................................................ 4
   4.1. General functions regardless of permissions ...................................................................................... 5
   4.1.1. News .................................................................................................................................................. 5
   4.1.2. View mode and sort option ............................................................................................................. 5
       4.1.2.1. Change view .............................................................................................................................. 5
       4.1.2.2. Sorting options .......................................................................................................................... 6
   4.2. Functions for users who have only read rights ................................................................................... 6
   4.3. Features for users who have read and write access ........................................................................... 6
       4.3.1. Create files and subfolders ........................................................................................................ 7
       4.3.2. Manage folder/file ....................................................................................................................... 7
           4.3.2.1. Download .............................................................................................................................. 7
           4.3.2.2. Change ...................................................................................................................................... 8
           4.3.2.3. Clear ........................................................................................................................................ 8
           4.3.2.4. Moving files .......................................................................................................................... 8
           4.3.2.5. Copy files .............................................................................................................................. 8
   4.4. Edit documents online together ......................................................................................................... 9
5. Terms of Use ............................................................................................................................................ 13
   5.1. Performance and user circle ............................................................................................................ 13
6. Contact details and contact persons ....................................................................................................... 13
1. Introduction
Inter-institutional and interdisciplinary science and research requires team-oriented work. Thus, the demand for suitable products that support such collaboration increases. Working together and simply exchanging documents flexibly in this context is an important prerequisite.
With Unibox, the University of Rostock provides such a service to students and employees of the University of Rostock. With the online storage service, it is possible to exchange, edit, save and synchronize data between users, desktop computers and mobile devices. Data access is cross-platform via a web browser. University members have the opportunity to exchange data with external users or to provide this data.

2. Accept invitation
If a university member has invited you to a folder, you will receive two e-mails from the Unibox at the specified e-mail address. You will receive an e-mail with the subject "Welcome to PowerFolder" and an e-mail with the subject line "Invitation to Folder Foldername". The latter contains only the information to which folder you have been invited by whom.

With the email "Welcome to PowerFolder" you can activate your account. Select the option "Account activation".

Then you will be redirected to the registration page and can create the account.
Your e-mail address is already filled in and can not be changed. Enter your first and last name and set a suitable password, please note the password policies.

Agree to the terms of service and click "Register" to create your account.

3. Login
After successful registration, you can log in via the website https://unibox.uni-rostock.de with the self-set password.

4. Utilization
After logging in, you end up in the "Folders" view. Here you will see the folders provided for you. The folder owner has the possibility to give you only reading rights or reading and writing rights for the folder. Depending on what rights you have for the folder and its contents you have different options.
4.1. General functions regardless of permissions

4.1.1. News

The News section give you the option to see when the files and what type of file have been uploaded, updated or deleted in the folders. Newly uploaded files are blue, updated files orange and deleted files red.

4.1.2. View mode and sort option

4.1.2.1. Change view

In the web interface, there are various view options at the folder level. You can switch between three different views using the view icon.

- **List:** This is the default view mode. This shows all subfolders and files in the current directory and shows most information about the files and subfolders.

- **Grid:** This view mode displays all icons next to each other and gives the name under each object.

- **Gallery:** This view only works for folders containing images. This view opens the images in a slider.
4.1.2.2. Sorting options
The list of contents can be sorted by clicking on the name of the section to be sorted. Click again to change the sort option. A small arrow indicates the direction in which the sort option is being used.

4.2. Functions for users who have only read rights
If you have released a folder with read-only rights from a university member, you can download or leave this folder if you no longer wish to subscribe to the data.

Switch to the shared folder, you can individually download the files contained therein and read them in the online editor.

4.3. Features for users who have read and write access
If the owner of the folder has granted you read and write access, you have several options for working with the files and folders contained therein.
If you have been granted read and write access, you can edit the documents and also have functions such as copy / paste, cut and delete for files and subfolders.

4.3.1. Create files and subfolders

Subfolders icon can be created in the shared folder. This is followed by the assignment of a folder name and the folder is created.

4.3.2. Manage folder/file

4.3.2.1. Download

Through the web interface, files and folders can be downloaded from the server. To do this, mark the folders or files by selecting the checkbox of the folder. This checkbox appears as soon as you move the mouse over the folder.

After selecting all desired folders or files, you can download the folders using the download icon.

If you select one or more folders for download, the folders will be downloaded with all their contents. If you select one or more files within a folder, only the selected files will be downloaded.
4.3.2.2. **Change**

File names and subfolder names can be renamed via the web interface. To do this, click on the **Rename-icon** and enter a new name in the corresponding subfolder or file dialog box.

4.3.2.3. **Clear**

Each folder with its contents as well as individual files can be deleted via the web interface via the **delete symbol**.

4.3.2.4. **Moving files**

Within a folder, you have the option to cut files from one folder at the file level and paste them into another folder, thus moving them.

To do this, select one or more files and select the **Cut-icon**. Then navigate to the folder where you want to move the file. In this folder, you will be offered the **Paste-icon**. This will insert the file into the folder and move the file.

Another possibility, as far as the file is to be moved only to a folder level below, is to drag the file to the new folder.

This file will be moved to the subfolder.

4.3.2.5. **Copy files**

Within a folder, you have the option of copying files within the same folder at the file level. To do this, select a file and select the **Copy-icon**. This is followed by a dialog box in which you can assign a new name for the copied file.
4.4. Edit documents online together

At the Unibox, documents are stored in the cloud and are thus available everywhere and at any time. Thanks to the integrated editor of OnlyOffice, it is possible to process documents directly in the Unibox. Simply click on the relevant document (presentation, document or table) and OnlyOffice will automatically start in the Unibox. The documents can be edited simultaneously by multiple users online from different locations. The changes are marked in different colors depending on the user. The integrated comment and chat function also facilitates collaboration.

By clicking on the document in the Unibox, this opens via OnlyOffice in the web browser. Here the document can be edited together. The editor is built in the same way as other word processing programs, such as Microsoft Office or Open Office. By default, the editor opens in the "Home" tab. In this tab you will find all editing options, such as fonts, paragraph settings and styles.

The **File** tab automatically opens the "Download as ..." menu. This allows you to download the document in different formats.

The document can be saved and printed under the same menu item. In addition, settings can be made. Furthermore, there is a help with useful information on handling OnlyOffice.

In the **Insert** tab, illustrations, comments, headers and footers can be inserted into the document.
In the **Layout** tab, general document settings for the layout, such as Size, margins, columns, paragraphs, etc. are made.

<table>
<thead>
<tr>
<th>ONLYOFFICE</th>
<th>File</th>
<th>Home</th>
<th>Insert</th>
<th>Layout</th>
<th>References</th>
<th>Collaboration</th>
<th>Plugins</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In the **References** tab, the table of contents and footnotes can be created and updated, and links can be created and customized.

<table>
<thead>
<tr>
<th>ONLYOFFICE</th>
<th>File</th>
<th>Home</th>
<th>Insert</th>
<th>Layout</th>
<th>References</th>
<th>Collaboration</th>
<th>Plugins</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In the **Collaboration** tab you can set the synchronization of the document for collaboration, make comments, view changes, monitor, accept, reject, or edit.

<table>
<thead>
<tr>
<th>ONLYOFFICE</th>
<th>File</th>
<th>Home</th>
<th>Insert</th>
<th>Layout</th>
<th>References</th>
<th>Collaboration</th>
<th>Plugins</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In the tab **Plugins** various additional contents can be integrated, like e.g. Macros, clip art, OCR, voice memos, icons, translator, youtube videos and embedded images.

<table>
<thead>
<tr>
<th>ONLYOFFICE</th>
<th>File</th>
<th>Home</th>
<th>Insert</th>
<th>Layout</th>
<th>References</th>
<th>Collaboration</th>
<th>Plugins</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In the column on the left side it is possible to comment on certain text passages, to respond to existing comments or to talk in real time in the chat, for example to better vote on changes.

**Comment on text passages**: The comments throughout the document are displayed in the left comments column. In the document itself, the comments are displayed as a speech bubble. Via the comment column it is possible to jump to the place of the comment within the document. Click on the comment and you will get directly to the page where the comment is written.
Entertainment in real time:

Within the Online Editor, the users of the document can chat with each other and thus make arrangements and discussions. The chat history is deleted as soon as the document is closed.

Anyone who has access to this document can edit it online. In this case, a parallel work of multiple users is possible. Each user is assigned a separate color, which clearly indicates which user made which change. The other users have the opportunity to accept or undo these. To see clearly what has been changed you can record the changes at the bottom under the button "Track Changes".

While the document is being edited there are further options for the respective action on the right side. If you write a text, for example, you can change the line spacing or adjust the background color. If you create a table, you can adjust the table colors, change frame, adjust row and column sizes.

There is also this option menu for pictures, headings, footers and headers, as well as diagrams. In addition, advanced settings can be displayed for each menu, which opens a dialog box with further options.
Advanced settings:

- **Line Spacing**
  - Multiple: 1.08

- **Paragraph Spacing**
  - Before: 0 cm
  - After: 0.28 cm

- **Don’t add interval between paragraphs of the same style**

- **Background color**

  Show advanced settings

If several users are working on a document, a number of users appears in the upper right corner. It shows how many users are working on the document in parallel. If you click on the user icon, the currently working users are displayed.

Toolbars can be switched on and off, the page size is adapted to the window and the settings are opened via the icon “**View Settings**”:
5. Terms of Use

5.1. Performance and user circle
The service Unibox is an online storage service, which is available to employees and students of the University of Rostock. This allows authorized users to synchronize their data between the desktop computers, mobile devices and the storage system of the IT and Media Center (ITMZ) of the University of Rostock. The transmission is encrypted. Furthermore, the user has the option of making stored data accessible to other users by assigning the appropriate access rights. To synchronize the data between user terminals and the storage system of the ITMZ, this provides in cooperation with Powerfolder for various operating system client software for free download. Access to the data can also be cross-platform via web browser. The service is not suitable for storing personal data. Furthermore, the privacy policy and the terms of use of the IT & Media Center apply.

6. Contact details and contact persons
If you have any questions or problems concerning the Unibox, please contact the ITMZ staff. You can reach us via the e-mail address: unibox.support@uni-rostock.de

We are also available by phone:
Josephin Tschakste  +49 381 498-5347

representative:
Jörg Zerbe  +49 381 498 5320